What Are We Talking About?
A Partial Glossary of Mac/Apple Terminology
active window The window in front, with the glossy red, yellow, and green
buttons glowing, where anything you type will show up or any
action you take will occur. Click on any part of a window to
make it active.
AIFF

Audio Interchange File Format, used to save a sound sampled
at specified intervals. Larger (and perhaps more accurate sound
reproduction) than MP3 files.

Airport

Apple’s wireless networking of Macs with each other or the
Internet.

alert box

A box that appears on the screen with a message from your
Mac. It won’t go away, and you can’t do anything else, until you
click OK.

alias

A copy of a file’s icon that you can double-click to open the
parent file. Handy to open applications that need to be kept
with their helper files in an inconvenient location. The items in
the Dock and in the left column of Finder windows are similar.

antialiased

Smoothed out.

Apple menu

The menu that rolls down when you click-and-hold on the black
apple at the left end of your menu bar (which see). Its items, like
those in the Dock (which see) are always available to you,
regardless of what program you are using.

AppleTalk

The language older Macs used to connect to and direct
operation of certain attached equipment.

application

Program (or software), such as TextEdit, that you use to perform
tasks on the Mac.

ASCII

Pronounced AS-key, it indicates a basic text file without
formatting. If you are sending a file to someone whose
equipment is older or PC, he will probably be able to open a
document in this format but might not be able to open a
document saved in your word processor’s usual format. In
TextEdit and most other word processors you can choose which
format to save your document in (see also text and RTF).

background

A program can be running, and working, in the background on
your Mac while you are actually working on something else.
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backing up

Making a copy of a document, or the contents of your hard
drive, so that you won’t lose your data if your Mac or its hard
drive fails (see also Time Machine).

baud rate (bps) How fast your modem is transferring information to and from
your Internet Service Provider (ISP). 56 kbps (thousand bits per
second) is tops for standard phone hookups (even if your
modem could do better, the phone line can’t); 1.5 Mbps
(million!) is a low rate for downloading on DSL or cable, which
for some users now reaches 45 Mbps.
BBS

(Electronic) Bulletin Board System. DVMUG’s runs on
FirstClass software.

beta, beta test

Not-quite-ready-for-prime-time software and sometimes
hardware tested by people who are willing to risk the
occasional crash to find the bugs that caused them.

bit

Bits are the basic, tiny components of computer programs,
documents, etc. They aggregate to become bytes (each
containing 8 bits), kilobytes, megabytes, gigabytes...

bitmap

A collection of dots that makes a picture, or a letter...a way for
your computer to remember how a drawing or photo looks.

Bluetooth

Short-range radio connection to communicate between your
computer and, say, a wireless printer or other peripheral. Good
up to about 30 feet.

boot

To start up your computer.

bps

Bits per second; see baud rate.

browser

Internet browser—the program that allows your computer to
explore the Internet. The major browsers for the Mac are Safari,
which comes with OS X; and Google’s Chrome and Mozailla’s
Firefox, which are free for the download. Chrome sometimes
works for sites that don’t behave properly in Safari.

bug

A software programming error that makes your computer crash
or otherwise misbehave.

bus

Wiring connecting components inside your computer.

button

Apart from the physical buttons your computer has, like the one
on the mouse and the power button, your screen will
occasionally show buttons in a box on the screen where you
have to click to make choices (Don’t Save, Cancel, or Save, for
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example). Typically the box the buttons are in won’t go away
until you click something.
byte

See bit

cable

If not a physical wire, one of the two fast Internet services
available to consumers. The signal is carried by your television
cable connection to a cable modem, and is an extra-cost service.
The other fast connection is DSL (which see).

cache

A spot where the Mac keeps stuff it thinks it will need again.
Using a cache speeds up your Mac since it doesn’t have to keep
going back to the hard disk or the Internet for bits of
information it needs to operate.

CAD

Computer-aided design.

Caps Lock

Makes all the letters capitals; it’s easy to hit by mistake when
reaching for the Shift or Tab key. Pressing it again turns it off, or
you can disable it in System Preferences > Keyboard.

card

A printed circuit board that adds a capability to your computer.

CD-R

A CD on which you can record your own material with a
“burner” to make a CD-ROM. See also DVD. Apple feels that
these technologies are on the way out, as availability of content
over the Internet improves.

CD-RW

Like a CD-R except that you can overwrite old material; not as
reliable.

channel

Individual sound source.

click

Press and release the mouse button.

clip art

Drawings and photos available on CDs or from the Web, or
within some programs such as Word that you can use to
illustrate your own documents.

Clipboard

When you cut or copy something, it is kept on the Clipboard
until you cut or copy something else, or turn off your computer.

Cloud

Web-based services, software, and heaven-knows-what that you
get from the Internet, through free download or subscription.
Apple’s iCloud is our very own. It will sync your Mac, iPhone,
and iPad.
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clock rate or
speed

The gigahertz (GHz) of a computer’s processor gives a rough
idea of the relative speed compared to other computers; more is,
of course, better, all other things being equal (which they never
are). Apple’s GHz is often lower than that of competing
Windows machines, but Macs can accomplish some tasks far
faster nevertheless. Go figure!

clone

An exact copy of a graphic, document, or hard drive.

Codec

Software that determines how an audio or video file is coded
and decoded.

command

You give them to your Mac by pressing the Command key and,
while holding it down, another key or two—for example,
Command–P for printing a document, Command–S for saving
it, etc. (A selection of key commands shows in program menus.)

Control key

Displays contextual menus that can help speed up your work.
In some programs, lets you give instructions or commands.

copy

When you use this command (in the Edit menu in virtually all
Mac applications), you can place a copy of the selected text or
graphic on the Clipboard (which see) and then can paste (which
see) it into another location or document.

CPU

Central processing unit—your Mac’s “brains.” This is the heart
of your computer.

crash

A program unexpectedly quits, or your mouse freezes and will
not respond to your clicks or movements. Sometimes it’s a bug,
an imperfection in the program. Sometimes it’s something you
did, such as issuing commands faster than your Mac could
digest them. In OS X, all you have to do is force-quit the
program (from the Apple menu, or use the key command
Command-option-escape)— and reboot it, and all you’ve lost is
unsaved changes (this is why you should save early and often).
If crashes happen consistently when you are doing a particular
operation, check the software vendor’s Web site to see if there’s
an upgrade to the program to fix your problem, or post the
problem on the DVMUG BBS for assistance.

CRT

Old monitor, pretty much replaced by flat-panel screens.
Basically, it’s a TV set being operated by your computer. The
letters stand for Cathode Ray Tube.

cursor

The pointer on the screen. You control it by moving your mouse
or trackball. It’s confusing in some programs because you get
TWO cursors—the pointer plus an I-beam, which shows you
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where your next typing is going to appear. The I-beam can be
moved by the little arrows on your keyboard as well as by
clicking somewhere else with your mouse.
cut
(Command-X)

By using this command (in the Edit menu in virtually all Mac
applications), you can remove the selected copy or graphic. It
will be saved to the Clipboard (which see) so that you can paste
(which see) it into another location or another document. On the
other hand, if you use the Delete key to remove the selected
item, it’s gone for good (unless you use the Undo command
right away).

daisy chain

A collection of additional equipment (scanner, extra hard drive,
CD burner, etc.) plugged into each other, with one plugged into
your Mac. You can daisy-chain FireWire or Thunderbolt
devices; to use multiple USB devices, you need a hub (which see).

data

Any information on your hard disks (or CDs, DVDs, iCloud or
other online account). You create new data when you type,
draw, or make your Mac calculate, etc.

database

An electronic collection of information that can be manipulated
in a variety of ways.

data transfer
rate

How fast data moves from one point to another, inside your
computer or to and from peripheral equipment. Also called
throughput.

default

The settings that the factory or software manufacturer installed
in your computer. Often they can be changed or supplemented
to make your Mac work better or help it perform specific tasks.

defragment

To place all the bits of a file in one spot so your computer can
access it more quickly. Your hard drive may speed up if you
use a utilitiy to defragment it; sometimes this helps in projects
such as editing movies, which involve large files. See fragment.

Delete key

Similar to the backspace key on a typewriter, but "disappears"
the letter rather than just going back over it. Some keyboards
also have a "forward delete" key or keystroke combination so
the next letter, rather than the previous letter, disappears.

deselect

See select

desktop

What you see when your computer starts up—the screen, icons,
Dock, etc. Also the gray, colored, or photo background on your
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screen. The term is sometimes used interchangeably with the
Finder.
Desktop file

A housekeeping file where your Mac stores information about
your icons, where your files are located, which programs open
them, etc. If it becomes corrupted—you can sometimes tell,
because your desktop icons turn into generic pieces of “paper,”
rather than the little individual pictures you’re used to—you
can rebuild it by holding down the Command and Option keys
at startup, but this seldom happens in OS X.

desktop
publishing

Creating newsletters, magazines, and books on your computer.

dialog box

A box that pops up when you need to specify how many copies
to print, what to name the document you are saving, etc.

digital zoom

The digital camera estimates what the subject would look like if
it were bigger. Inferior, in digital camera specifications, to
“optical zoom.”

digitize

Making sound or pictures into files that your Mac can work
with; converting from an analog (vinyl records or audio tapes,
or film) to a digital format.

dimmed

See grayed out

disk cache

A chunk of memory set aside for things that your Mac uses a
lot, so it won't have to keep getting them from the hard drive.
Can speed up processing.

disk drive

The gadget that reads what's on your disk. For a hard drive, the
magnetic medium and the disk drive are one unit; you insert the
disk into a CD disk, or optical, drive.

document

A file that you create using an application (or program or
software).

documentation User's guide or manual. Most are now on screen rather than on
paper, but O’Reilly Press, which gives user group members a
35% discount, has been publishing a series of Missing Manuals;
they and Peachpit Press produce a variety of “how-to” books
for users at all levels; Frys in Concord carries a fair number of
them.
Dock

The new-in-OS X combination of the old Application Menu,
Control Strip, Apple Menu, and Launcher. Shows what
applications are open, lets you access or change applications
quickly, and has a Way Cool Genie Effect when windows slide
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into it. Icons of open applications will always appear in the
Dock, but you can also put your favorites there for easy access.
DOS

Disk Operating System used by older non-Macintosh
computers.

dot matrix

Apple's old Imagewriter and similar printers that created letters
and images using small pins striking a typewriter-like ribbon,
technology now completely outmoded by inkjet and laser
printers.

dots per inch

AKA dpi. The more on your screen or document, the clearer the
picture. Old Macs screen probably had 72 dpi; current screens
may have 2560-by-1600 resolution or better; inkjet and laser
printers can print 300 or 600 or even more.

dot pitch

The distance between pixels on your screen. The further, the
granier the picture.

double-click

Depress and release your mouse button twice in quick
succession without moving your mouse. The speed at which
your Mac accepts your clicks can be adjusted in System
Preferences > Mouse or Trackpad. Ordinarily, single-clicking on
an item or icon selects it and double-clicking opens it, but
single-clicking a button will make something happen, and
single-clicking an item in your Dock will open it.

download

A file transferred from one computer to another. The receiving
computer is downloading; the sending computer is uploading.
When you download something from the Internet, the material
is coming over your telephone or cable line from the remote
computer, usually a server.

dpi

See dots per inch

drag

To position the cursor on an object on your computer screen
and move the mouse while holding down the mouse button.
Some programs support "drag and drop"—you can drag
selected text or objects from one part of a document to another,
from one document to another, or to your desktop.

drawing
program

A program that saves the circles, lines, and rectangles that you
create in it as objects, rather than as a collection of screen dots,
so that it prints out more smoothly than objects created in paint
programs or as bitmaps (which see).

driver

Software that tells the Mac how to operate a piece of added
equipment, such as a scanner or printer.
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drop-down
program

When you click on an item in the menu bar (which see) a list of
commands drops down. The ones that you may choose are
black; the ones that don’t apply to what you’re doing are gray.
Remember that you must select the icon or item that you want
to modify before you can click on the command to modify it.

DSL

Digital Subscriber Line, a way of “splitting” your telephone line
to carry voice messages and your computer’s data at the same
time. A DSL connection is much faster than the conventional
telephone modem connection but also more expensive. DSL
connections are generally only available within about three
miles of the telephone switching office or a “booster” switch.

DVD

Digital Versatile (or Video) Disk, the favored format for making
disks con-taining videos but also usable for large amounts of
data. A video burned on to such a disk can, usually, be read by
an ordinary DVD player. DVD disks are more expensive than
CD disks but hold much more.

e-mail or email The “e” is for electronic; messages that you send with your
computer over the Internet to somebody else's computer.
Enter key

Hitting it usually does the same thing as hitting the Return key
except in word processing documents.

EPS

Encapsulated Postscript. A type of graphics file that gives sharp,
well defined details when printed on a PostScript™ laser
printer

Ethernet

A way of connecting Macs to each other or to the Internet via a
DSL or cable modem. Older versions allowed 10 Mbps to be
transferred; newer ones are up to 1000 Mbps. Now essentially
passé, replaced by USB and Thunderbolt.

expansion slot

Socket for adding a circuit board inside the Mac (or on the edges
of some laptops) to add functions such as networking,
accelerators, etc.

fax

You can send and receive faxes on your Mac if it’s hooked up to
a phone line; you can buy a modem for Intel Macs, which don’t
include one. Outgoing faxes can be documents created on the
Mac or scanned in; incoming faxes are PICT or TIFF (which see)
files and cannot be opened in a word processor. It’s probably
more trouble than it’s worth in these days of easy attachments
to emails, and current Macs don’t readily support it.
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field

A blank space in a database to be filled in. Your Address
Book/Contacts is a simple database, Filemaker Pro a fancier
one.

file

A program or document on your computer; represented by an
icon (which see)

file
compression

Squishing a file with with the Finder’s Compress command so
that it doesn't take up as much room; often done to send files
more quickly over the Internet. Compressed files that you
receive will usually open with a double-click, assuming you
have the same software.

file sharing

You can make your files and other items available to others on
your network and vice versa in System Preferences > Sharing.
When you’re done sharing, turn it off to increase your Mac’s
security.

Finder

The program that manages the Desktop (which see).

firewall

A security device, software and/or hardware, that prevents
“outsiders” from accessing your Mac network over the Internet.
You can turn on the OS X firewall in your Mac’s Sharing System
Preference pane.

FireWire

Apple’s name for a fast connection for older external hard
drives, CD burners, digital cameras and camcorders, etc. Being
replaced by Thunderbolt and USB connections.

firmware

A modification to your computer’s ROM (read-only memory).
Formerly ROM was hard-wired into your computer; on newer
Macs it can be modified by new software.

Fkey

Function keys, the row of keys above the numbers at the top
your keyboard.

flash drive

A small drive that fits in a USB port; also called a thumb drive.

folder

Just like the manila variety: You keep stuff in it—documents,
applications, other folders. To put something in one, just drag
the item’s icon into its window or on top of the folder’s own
icon. The Mac’s hierarchal folder system is one of its
beauties...and one of its most confusing aspects for beginners.
But once you “get it,” you’ll love it!

font

In common computer usage (though not that of publishing
pros), a typeface family: for example, Helvetica plain, italic, and
bold in various sizes.
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footers

See headers

footprint

The amount of space your Mac, or a peripheral, takes up on the
top of your desk.

FPS

Frames per second; the more, the more lifelike your movie will
look.

fragmentation

When you save a file, your Mac uses whatever disk space it
finds first; if the first space it finds can’t hold the whole thing,
the Mac dumps into it whatever it WILL hold and goes on
looking for a home for the rest of it. Eventually, after you’ve
saved hundreds and hundreds of documents, your hard disk
will take longer to find all the pieces of any given file and open
it. See defragmentation.

freeze

Your cursor won’t move, nothing happens when you type, and
your Mac is locked up. Time to press Command-Option-Escape!
If that fails, hold the Power button down until your Mac turns
off. Probably everything will be fine when you restart.

function key

Or Fkey, which see.

Get Info

A Finder > File menu command that tells you a file’s size, type,
etc.

GHz

Gigahertz. Essentially indicates how fast your Mac is, though
other factors such as the amount of RAM installed also come
into play. The more, the better. Find yours in “About this Mac”
in the Apple menu.

GIF

Graphics Interchange Format. A format for saving
photo/graphics files. Usually you run across it in a file
somebody sent you over the Internet; use Graphic Converter (an
inexpensive program from Lemke Software) to open it if your
browser or Preview (a versatile reader that comes with OS X)
won’t.

gig

Or gigabyte: 1,024 megabytes, or lots and lots of bytes.

grayed out

In a menu, only the commands that you can actually use at that
moment appear in firm black type; the others are grayed out.
For example, if you haven’t selected anything to cut or copy,
those commands would be grayed out in the Edit menu.

grayscale

All of the colors are rendered as different shades of gray. If you
have a cheap laser printer, this is what you’ll get as output
instead of color.
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hang

See freeze.

hard copy

Printed copy.

hard disk or
drive

Spinning platters—remember the old vinyl records? Somewhat
similar, except that hard drives are magnetic rather than
grooved; your hard drive is where your Mac stores your
documents, applications, everything. They can be internal or
external, in which case they will be attached via a USB or
FireWire port (which see). New Macs may (also) have SSDs,
which see.

hardware

The parts of your Mac that you can see when it isn’t turned on:
monitor, keyboard, circuit boards (if you take it apart), etc.
Contrast with software, the instructions that are loaded into
RAM when your Mac starts up to make it run.

header

A page number, title, or other information that appears at the
top of each page of a document. Most word processing
programs allow you to set a header giving whatever
information you like, with page numbers set according to your
instructions. Footers perform the same functions but go at the
bottoms of the pages.

highlighting

To select, by double-clicking or dragging the cursor over the
text or graphic. A highlighted item will be indicated by a box or
colored area; color depends on what you select in the
Appearance System Preference.

http

Hypertext Transfer Protocol, describing how Web data is to be
transferred between the Web page server and your Mac.
“Https” means that a Secure protocol will be used so the
information can’t be read in transit—you should always see this
ahead of the web page’s URL before you send a credit card
number or any personal/financial information.

hub

A device that lets you plug several pieces of equipment (printer,
scanner, camera...) into just one outlet on your Mac. USB hubs
come powered and unpowered; choose powered since many
devices draw their operating juice from the USB connection,
and your Mac only has so much to spread around. FireWire
hubs work the same way.

I-beam

In a text document, shows where anything you type will
appear, or where your selection will start if you click or drag.
See insertion point
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icon

A tiny picture on your screen that represents a file, program,
folder, or disk.

initializing

Erasing a disk, to solve problems or install new software.

inkjet

Printers that spray tiny droplets of ink to form images.

insertion point If you move your pointer into a text document, it becomes “I”shaped. When you click, it creates a flashing vertical line. That’s
where your text will appear when you type. Or disappear, if
you hit “Delete.”
Internet

A worldwide network of computers connected by telephone
and cable lines, it allows us to have Web pages, e-mail, and
dot.coms.

ISP

Internet Service Provider. This is a company that acts as a
conduit between your computer and the Internet. Some
examples are Internet Frontier, ATT, Comcast, America Online
(AOL), and Earthlink, and the connection can be DSL, cable, or
dialup (rare now). Providing the conduit does not necessarily
mean that you have an email account with these folks (though
you generally do), and you can also have a Gmail or other
account that uses the connection. Even if you have a Gmail
account, you should set up an account with your ISP as an
emergency backup.

iToy

iPhone, iPad, iPod. The iPhone has morphed into a pretty
multifunctional computer with a phone. If you have teeny
fingers, you can use it to send and receive email, edit Pages
documents, and do a variety of on-the-go computing tasks.
Originally designed as a music player, the iPod is essentially the
iPhone without a phone bill; the iPad is a larger-screen version
of the iPod. They all run on Apple’s iOS operating system.

jaggies

Ragged edges in onscreen letters or graphics.

jpeg

Joint Photographic Experts Group. A graphics-file format, very
common, especially on PC-generated documents. Opens in
many graphics and browser programs as well as many word
processors. Sometimes abbreviated as jpg.

k

Short for kilobyte, 1024 bytes. A (small) unit of size for
computer files; a typical business letter might be as little as 2-4k.

kern

To move letters in words closer together or farther apart to
improve the appearance of the sentence/paragraph.
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key commands The Command (or apple) key plus any of several letter keys can
do amazing things without your fingers having to leave the
keyboard.
landscape

When you set your printer to “landscape,” your paper will
come out sideways. This is good for some spreadsheets,
artwork, etc., but usually bad for letters and similar documents.
See portrait.

laptop

Portable computer that can run on batteries.

laser printer

Similar to a copier, these printers produce sharp copies quickly.
They are more expensive than the inkjets, but may save money
in the long run since their cartridges are cheaper per copy than
inkjet cartridges.

launch

To start up a program.

LCD

Liquid Crystal Display, used in laptops and Apple’s flat screens.

leading

Pronounced ledding; the space between the lines of a document.
For example, a document that is double-spaced has the same
leading as the size of the type; most books and magazines have
leading of about one point larger than the type size so that the
descenders (the letters such as y, g, p that have a foot
descending below the base line) don’t hit the ascenders (h, l, d,
etc) that reach upwards.

LocalTalk

Pre-OS X Macintosh network connections and protocol that
allow several Macs to share printers, etc.

lock

You can restrict permissions on a file so it cannot be changed by
mistake.

logic board

Your Mac’s main circuit board. If it fails, your Mac won’t work.

Mac OS

The operating system software that makes your Mac a Mac. The
corresponding concept for PCs is Windows, now Windows 10.

macro

In some programs you can record a series of actions so that they
will repeat with the press of a single key.

mail merge

This is how you get “personal” letters from huge corporations:
they have your name and address “merged” into a form letter.

MB, megs

See megabyte.

Mbps

Millions of bits per second
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megabyte

A unit of storage space or memory that equals 1024 kilobytes.
More is better.

memory

Refers to the capacity that your Mac has to handle large files, or
more than one program at once. Also called RAM (random
access memory). You’ll be happier if your Mac has at least 4
gigabytes of RAM, and more is better, especially if you work
with large files or photographs.

menu

A list of commands that drops down when you click on one of
the words on the Menu Bar (the stripe bar at the top of your
screen).

MIDI

Musical Instrument Digital Interface. Play your music on your
Mac!

MP3

Motion Pictures Expert Group One, Audio Layer 3, a format
that allows digitized music (on CDs, for example) to be saved in
much smaller space than the original, making sharing of music
files over the Internet more practical. MP4 is a standard for
movies.

modem

A gadget that allows your Mac to connect to other computers or
the Internet over the telephone line. Stands for modulate
(translating your Mac’s output into something the telephone
line can handle)/demodulate (translating the translation back
into something your Mac can handle). They were built into most
Macs prior to the introduction of Intel Macs. Term has been
extended to cover DSL- and cable-connecting devices.

modifier keys

Keys that change what the letter keys do. For example, a p is
just a p, but hit the shift and it’s P; combined with the
Command (or apple) key it turns into the Print command.
Learning how the modifier keys work (learning key commands)
can speed up your Mac use considerably.

monitor

Your computer’s screen. Nowadays they’re generally built in; in
older models, the monitor was sold separately.

motherboard

See logic board.

mouse

It comes with every desktop Mac to control the location of the
cursor and to issue commands (click, double-click). Alternatives
include trackballs (which see), joysticks (nice for games), and
tablets (nice for artists). And of course laptops have trackpads
that perform the same functions.
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mouse pad

Makes the old-style mechanical mouse a happier mover. Less
needed for optical mice and unneeded for mouse alternatives
such as trackballs.

multimedia

Sound and pictures! Sound and moving pictures! The current Big
Thing.

nanosecond

One billionth of a second.

network

Connect two or more Macs and you’ve got a network. Offices
and schools use them; if you have two or more Macs at home
that want to share a printer or modem, you may want to set one
up too. Now you can do it wirelessly.

OCR

Optical Character Recognition. When you scan a document, a
good OCR program enables your word processing program to
recognize it as text rather than an elaborate picture, so you will
be able to edit it. Nowdays, of course, the document was
probably created on a computer anyway.

online

Hooked up to the Internet (or the DVMUG BBS!)

open

To make a document appear in a window on the screen or start
up an application. To do it, double-click on its name or icon, hit
Command-O, or go to the File menu. You must select—
highlight—what you want to open first!

optical
resolution

The resolution that your hardware (digital camera, camcorder,
or scanner) can achieve on its own. More important than the
digital resolution, which is just the device’s guess as to how the
subject would look if it were bigger.

paint program

A program that creates artwork based on individual dots on the
screen.

partitioning

Fooling a large hard drive into thinking it is two or more
smaller ones. Helpful for using video editing programs, which
like to have disk space to themselves.

paste
(Edit menu)
PC

After you cut (which see) or copy (which see) a piece of text or a
graphic, you can paste it into another location or document.
Personal Computer (though other definitions, such as “Pretty
Crummy” and “Poor Choice” have been heard); used to refer to
that host of Other Computers that run with Microsoft’s
operating system.
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PCI

Peripheral Component Interconnect, hardware to add
connection and other capabilities to your Mac.

.pdf

Portable Document Format, invented by Adobe so PCs and
Macs could read each other’s stuff. Apple’s Preview is used on
newer Macs rather than Adobe’s Reader.

peripheral

An added piece of equipment: scanner, printer, CD burner, etc.

PICT

Picture file; based on individual dots on the screen, so it can
have jagged edges.

pixel

A single dot on the screen; supposedly stands for picture
element.

plugin

A “programlet” that adds an ability to a program. Sherlock
plugins, for example, allow it to search additional Web sites;
other plugins enable additional functions for Safari, Firefox, and
other browsers.

png

Portable Network Graphics. Another format for pictures, like
.jpg and .gif (which see).

pop-up menu

Usually indicated by upward and/or downward pointing
arrows, or a tab at the edge of a window, it gives you more
choices.

port

A connection jack where you can attach additional equipment
(peripherals, which see) to your Mac. Current Macs have USB
(Universal Serial Bus) ports, FireWire or Thunderbolt ports, as
well as speaker, microphone, and video ports. And sometimes
others!

portrait

The way you would expect your letter to print on the paper,
with the shorter sides of the paper at the top and bottom. The
alternative is landscape (which see).

POP

Post Office Protocol—the software your ISP uses to pick up and
send you your email.

PostScript

Adobe invented this to smooth (eliminate jagged edges on)
printed type fonts and graphics, as well as screen displays.

PowerBook

Older Mac laptop computer. Current Mac laptops are the
MacBooks and MacBook Pros.

Power
Macintosh

Line of Macs using the PowerPC chip, made starting in 1994 or
thereabouts. Now totally outdated and defunct.
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PRAM

Paramenter RAM; the memory retained by the Mac’s battery
that lets it remember the date, printer settings, and such
minutiae.

program

See Application.

QuickTime

Animations, sound, movies—QuickTime makes them possible
on your Mac.

Quit

This command, in the File menu on every Mac program, gets
you out of the current program and back to the previous
program or Finder. If it fails, you can Force Quit by holding
down the Command and Option keys and pressing the “Esc”
key at the top left corner of your keyboard.

radio button

See button.

RAM

Random Access Memory (which see), as opposed to storage
space available on your hard drive.

reboot

Shutting down and restarting your Mac.

rebuilding the
Desktop

record

Something to try if your Mac is acting strangely. To do it, hold
down the Command and Option keys at startup. Or start in Safe
mode by holding down the Shift key at startup until you see
“Safe Boot” in red letters.
One set of data in a database; for example, one person’s name,
address, and phone number.

Recovery Mode Hold down the Command and R keys at startup, or hold down
the Option key to show a screen that will let you choose to start
up from the Recovery partition on your hard drive
relational
database
Your customer database could be linked to a separate database
containing your accounts or product listing.
resolution
How many dpi (which see) your monitor displays, or your
printer prints, or your scanner delivers. More is sharper but, on
monitors, also gives you smaller type, icons, etc. If you have
trouble reading the small print on your monitor, change it to a
smaller number in your Displays system preference.
ROM

Read-Only Memory; chips that have certain tasks permanently
built in, such as how to start up your Mac.

RTF

Rich Text Format. If you are sending a text document to
someone who doesn’t have the same word processing program,
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you can save it in “RTF” and chances are they will be able to
open it. This format saves some of the formatting, unlike “text”
(which see).
san serif

A font like Helvetica (which this is) that doesn’t have any
flourishes at the top and bottom of each letter. They work well
for titles and such but can make long documents harder to read.

save

A command that copies the document you are working on to
your disk or other storage device, so that you can close it and
then reopen it to work on it again.

scanner

A machine that takes a document and translates it into bits and
bytes that your Mac can “see.”

screen saver

Darkens or puts a moving picture on your screen when you
haven’t used your Mac for a while to prevent the image on the
screen from “burning in” and making excessive wear and tear
on your flat-panel screen; just touch a key to get your Desktop
back. Newer color monitors aren’t particularly prone to burn-in,
and an Energy Saver that darkens the screen automatically is
now built in, but some people think the flying toasters and other
screen-saver images make the Mac more decorative. You can
choose screen savers (and alternate Desktops) in System
Preferences > Desktop & Screen Savers, others can probably be
located online--try Google.

scroll

To use the arrows or scroll bar at the right or bottom of your
window (hidden unless you opt to have them shown in System
Preferences) to bring a different part of the document you’re
looking at into view. A button on the scroll bar shows you about
where you are in the document; when it’s in the middle of the
scroll bar, you are viewing the middle of the document.

serif

The little ledges that appear at the top and bottom of these
letters (but not in san serif fonts such as Helvetica).

shareware

Programs that are distributed for free or really cheap, but you
are honor-bound to pay a fee if you decide to use them on a
regular basis. There’s also freeware and donationware (please
send money) available.

Shut Down

Select it from the Apple menu to turn off your Mac properly,
making sure that all files are saved and all programs at rest.

SIG

Special Interest Group. DVMUG has several, including the
Internet SIG and the Digimedia SIG.
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Skype

This is the more-or-less free “phone” service you can use with
your Mac, iPhone, or iPad--because at core it really isn’t a
phone; you’re connecting over the Internet. If you connect to
somebody else’s computer, it’s free; if you want to call
somebody on a landline, there’s a monthly charge. To see if it
will work for you, look at http://www.skype.com/en/what-isskype/. Note that Apple has entered this game with Facetime,
but it’s only good for “calling” other Apple folks with Facetime
on their computers, which have to be running OS 10.6.6 (Snow
Leopard) or later. Both sides must buy the Facetime app at the
App Store (99¢) and have Apple IDs (accounts at the App
Store).

Sleep

Save energy (in fact, you control it in the Energy Saver control
panel) by putting your monitor and/or CPU into the Sleep
mode when you aren’t using it for a while but don’t want to
turn it off and go to the bother of rebooting. You can set your
Mac to Sleep automatically after a set period, or use the “Sleep”
command in the Special menu of the Finder; just touch a key to
wake it up and get the picture back.

slot

See expansion slot

SMTP

Simple Mail Transfer Protocol--the software that your ISP uses
to send your email.

software

The programs that let you do things on your Mac.

spreadsheet

An automated accounting program that lets you keep track of
your finances, stock portfolio, or whatever...can be used to
organize text, too. Numbers is Apple’s current almostspreadsheet offering; more people use Microsoft Windows’
Excel.

SSD

A solid-state drive (SSD), also known as a solid-state disk or
electronic disk,[4] though it contains no actual "disk" of any
kind, is a data storage device using integrated circuit assemblies
as memory. SSDs have no moving mechanical components.
Your Mac or iToy can access information on an SSD much faster
than it can read a hard drive, so some iMacs and MacBooks are
now coming with SSDs only or combined with a conventional
drive.

startup disk

Usually your Mac starts up from its internal hard drive, but in
times of trouble (for example, if you are having problems with
your hard drive) you can start it from the CD that came with it
(or that you bought with a utility program) or, in
Lion/Mountain Lion, and later, the Recovery section installed
in a separate partion of your hard drive; hold down the letter C
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(or R) while you turn the Mac on to start from a CD (or the
Recovery partition). Note that the Recovery partition won’t
work if the problem is that your hard drive has died.
submenu

Sometimes when you select a menu from the Menu Bar, you
will see arrows next to some items; they are pointing to
submenus that give you even more choices. You need a certain
amount of mouse skill to navigate to them successfully.

surge protector Electrical power is variable; an electric surge (for example, from
a lightning strike or power company malfunction) can fry your
Mac’s innards. A surge protector is sort of like a circuit breaker,
and will protect against such disasters. As usual, more (amps or
volts or whatever) of protection is better. And of course more
expensive!
System

The heart of your Mac. Tells the hardware how to be a Mac.

text

If you save your word processing document as “text,” any other
word processing program should be able to open it, whether
Mac or PC.

TFT

Thin FilmTransfer, the newer screen, is also called LCD (liquid
crystal display), or just “flat panel.” These screens are supposed
to be easier on the eyes than the traditional CRTs (which see).

throughput

How fast data moves from one point to another, inside your
computer or to and from peripheral equipment. Measured in
Mbps (which see).

thumb drive

See flash drive.

Time Machine

Software that can be set to back up your hard drive to an
external drive at regular intervals.

TIFF

Tagged Image File Format; the kind of picture file created by a
scanner. You can usually save it to a different format if you
need to, though.

title bar

The strip at the top of each window where the name of the
document or folder appears.

trackball

Basically an upside-down mouse. It looks like a marble or cue
ball in a little nest; you manipulate the ball directly with your
fingertips.

Trash

When you put something in the Trash, your Mac’s programs
can’t use it anymore; when you empty the Trash, it’s gone for
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good, short of a pretty difficult and potentially expensive
recovery job.
upload

See download

UPS

Not the brown trucks. Stands for Uninterruptible Power Source
(or Supply), a constantly charging battery pack that powers
your computer. It should have enough juice to power your
computer for several minutes in the event of a power failure, so
that you can save your work and shut down safely.

URL

Uniform Resource Locator, the “address” of a Web page.

USB ports

Universal Serial Bus, where you plug in your printer, keyboard,
mouse, etc.

User Group

Computer club, like RMUG and DVMUG, that serves as a
forum to spread information and rumors as well as assist
members to get the most out of their machines.

virus

A self-replicating program designed by a jerk to gum up a
computer’s working capability. Most, fortunately, are designed
to attack PCs, but anti-virus software is still desirable if you
download stuff from porn or other dubious sites on the Internet.
You can also get them from friends’ emails whose PCs have
been hacked, though they will probably find your Mac
indigestible.

volume

Any item—disk, hard disk partition, CD—represented by its
own icon on your desktop or in your Finder window.

VRAM

Video RAM (which see). RAM dedicated to running your
monitor/display. The more you have, the more colors you can
set your monitor to see and the faster your games will play.

wav

Waveform, the Windows version of AIFF (which see)

WiFi

Broadcast Internet connection. You get it from your own router
(which see) or from a signal in a public place--Starbuck’s,
airplane terminal, whatever. Your MacBook (don’t think we’ll
see many iMacs doing this!) can reach the Internet via local
network signals; private networks will probably be locked. In a
hotel or motel, you must usually ask for the network’s
password and sometimes (in pricier hotels) pay extra for it.

Wired

As opposed to WiFi, you must have an Ethernet cable to attach
to a modem or wall plug (in some hotels/motels) to make an
Internet connection. Can be a faster connection than WiFi.
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window

The rectangle that pops up on your desktop when you doubleclick on a Mac icon. It may contain a document, a list of files, a
game...it’s where you do what you do on your Mac.

word wrap

A word-processing program’s ability to figure out whether it
can get a word on the same line as the last one or has to go to
the next line. Saves hitting the “Return” button; in fact, if you
use “Return” for anything but starting a new paragraph, you
will find that formatting your word-processing documents is
very difficult.

WYSIWYG

The ability of the Mac to display on the screen what your
document will look like when printed out. What you see is what
you get. In early Mac days, a real contrast to the experience of
the Windows folks.

Xfinity

Comcast’s name for its lineup of offers of more speed and more
channels.

zoom box

The green gel tab on the top left of the title bar that enlarges
your window or shrinks it back down. It was a box in OS 9 and
earlier.
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